
RPMS Report and Information Processor (RRIP) 
Initial Setup and Use instructions 

What is the RPMS Report and Information Processor (or RRIP for short)? 
RRIP is a means by which a user can import RPMS reports into Excel which otherwise would be nearly 
impossible to get into Excel. This allows for more efficient use of data by making sorting and filtering 
available to these reports. 

What is the vision of RRIP? 
The vision for RRIP is to help IHS use data more effectively to produce better outcomes, increase 
revenue, and improve transparency. 

Important note on using the RRIP 
This instruction document does not replace the need to follow the information that the RRIP displays 
when you run a report.  It is imperative that you read all information in this document as well as 
what is displayed by the Excel macros to avoid problems. If possible, it is recommended that you 
have your pharmacy informaticist be the one to work through these instructions and get things going 
the first time. A copy of the in-program instructions can be found in Appendix A.    

What are pivot tables and pivot graphs? 
The RRIP for the Controlled Substance Management Report (CSM) and External Pharmacy RX Report 
(ERxT) creates pivot tables and pivot graphs. If you are unfamiliar with pivot tables and graphs, they 
are simply advanced tables and graphs for Excel that allow the user to look at data in ways regular 
tables and graphs do not allow. To keep the manual simple, all references to the CSM also apply to 
the CSM + ERxT as well.   

It is recommended that you have a screen resolution of at least 1280 x 960 to properly view the pivot 
tables/graphs and in-program instructions.  
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Initial Setup 

Protected View 
To get started, go ahead and open the RPMS Report and Information Processor (RRIP) Excel file. You 
may get a Protected View Warning. Click “Enable Editing” before continuing with these instructions. 

Security Warnings 
RRIP is a macro enabled workbook and as such, when you first open it you will most likely get a security 
warning on a yellow bar just below the Excel Ribbon. You will need to click on “Enable Content” before 
the RRIP macros will work. See below. Note: On some systems, you may get a second box that pops up 
after clicking “Enable Content.”  If you get the second box, just make sure that you tell it you want to 
enable the content.   

Security Warning Office 2013 

Security Warning Office 2010 
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Security Warning Office 2007 

Once you have enabled content, you will get the first instruction pop-up.  Please read it then click “Ok, 
I’ve got it.” If you don’t want to see those instructions again, click the “Don’t show these instructions 
again” before clicking “Ok, I’ve got it.” Follow the same procedure for each instruction pop-up you 
encounter.
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Navigation 

After you have enabled macros, you should see a popup with initial instructions on how to use the RRIP.  
The instructions will guide you to a few areas of the user interface.  They are illustrated below: 

1. Navigation Tabs: At the bottom of the sheet there are tabs that will take you to various sheets
of report processing buttons.

2. Instructions Button: Before you begin, you will want to click on the “General Instructions”
button to get more information on using the RRIP.

3. Report Specific Instructions Button: For each report you may want to process, there is a
“Specific Instructions” button that will have instructions specific to running the indicated report.

4. Report Processing Buttons: Once you have read the instructions, you are ready to start
processing your report. Clicking on the various colored buttons will allow you to process that
given report. When you click one of these buttons, you will get a popup where you can
customize how you want your report to be displayed and save those settings for future use.

5. Edit Settings Button: If you permanently save setting for one of your reports, but later decide
you want to edit those settings, just click the “Edit Settings” button and the next time you click
on the colored button to process that report, it will allow you to change and resave your
settings.

[Back to Top] 



5 

Screen Capturing 

Instructions for NetTerm and SecureCRT will be given. If you are using some other telnet client, the 
manner of screen capturing may be different. You may need to find someone in your facility who knows 
how to use screen capturing with your specific client to get specific instructions. 

Before performing your first screen capture, you will need to make sure that RPMS is displaying as many 
columns as possible to ensure that nothing gets truncated.  In NetTerm you would go to Options -> 
Setup -> Desktop Settings as pictured below: 

This will bring up a box that looks like the one below.  You will need to change the Columns from 80 to 
180 then click “OK”. 

1 

2 
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In SecureCRT, you would go to Options-> Session Options-> Emulation and change the columns to 255 as 
below:  

At this point go to file -> Session logging (or Log Session in SecureCRT) as below: 

[Back to Top] 



7 

A box will pop up where you will choose the file name you would like to use and location where you 
would like to save the file. See the picture below. You may need to add “.txt” to the end of the filename 
you choose if it isn’t already there. In the image below, I’m naming the file TEST1.txt and saving it to the 
desktop.  You will also need to change the “Files of type:” to “All Files”.  Note: If you fail to add “.txt” to 
the end of the filename, you can rename the file later and add “.txt”. 

Click “Open” (or “Save” in SecureCRT) to start the session log and go back to the RPMS window and run 
your report. At the Device: prompt in RPMS, I would suggest you type 0;180;999999999999 (that’s 
twelve 9’s) before hitting “Enter”. This will tell RPMS to print to home, use 180 columns, and 
999999999999 rows.  It is important that you use twelve 9s. Larger facilities may need even more than 
twelve to avoid errors when running the report.  Once your report has finished running, you will need to 
go and stop the session logging by the same method you used to start the session log.  Notice that the 
session logging option has a check next to it.  When you select it this time, it will remove the check and 
stop the session log.  Your .txt file will be ready to import into Excel using RRIP. See the image below: 

TEST1.txt 
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***You are now ready to use the RRIP.  As the RRIP makes use of many tools that most people are not 
familiar with, please make sure you read all of the in-program pop-ups as they will guide you and help 
you avoid confusion and frustration. Initially, they will take you a little time to go through, but after 
you are familiar with the RRIP, you will find that you can get the data you want within a minute or 
two. As mentioned at the beginning of this manual, a copy of the in-program instructions can be 
found in Appendix A.  Please remember that the .txt files and RRIP’d reports you create contain PHI 
and need to be safeguarded per IHS and HIPAA Regulations.  Lastly, if you are using the RRIP for a 
CSM report, please continue reading as there are important CSM specific instructions below.***  

CSM Setup – Allowing for Automatic Graph Resizing 

The CSM processor creates some useful graphs for evaluating the data in the CSM report. While you do 
not have to perform the following steps to get the graphs, if you do not perform the following steps, 
your graphs will not automatically update their size when you filter the data on the graphs. You will only 
have to perform these steps one time on each computer you use to run the RRIP.   

To allow your pivot table graphs to dynamically change size, please do the following: 
1. Go to File -> Options (not shown in the screenshot)
2. Click on “Trust Center”
3. Click on “Trust Center Settings”
4. A new window will come up – Instructions continued on next page
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5. Click on “Macro Settings”
6. Check the box next to “Trust access to the VBA project object model”
7. Click “OK” once to close this window and again to close the first window
8. You’re good to go now

CSM - Tips for the End User 
1. Instead of printing these reports, consider setting up your meetings where you will review the RRIP’s

CSM reports with a projector or large screen where you can view the report. 
2. Don’t forget you can use the dropdown filters that are on every tab to further drill down your data.

Most filters allow you to type in items in the search box allowing you to quickly select a specific item. 
Play around with the check boxes a bit to get a feel for their capabilities.  

3. There are colored tabs at the bottom of the main RRIP screen that contain important information.
Please have a look at them (except maybe the “Updates” tab – it’s pretty boring). 

6 
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4. The grey “Definitions and Explanations” tab in the main RRIP workbook is designed to be used as a
reference to better understand how the RRIP derives its data.  It is not designed to be something you
“must” read before using the RRIP.

CSM Report – Getting a List of all Chronic Opioid Therapy (COT) Patients 
In the CDC’s guidance for opioid quality improvement they define patients on long-term opioid therapy (i.e. 
chronic opioid therapy (COT)) as being those who have had opioids for 60 days in the last quarter. For a detailed 
explanation, see page 30 of the CDC Quality Improvement and Care Coordination: Implementing the CDC 
Guideline for Prescribing Opioids for Chronic Pain found in the link below:  

https://www.cdc.gov/drugoverdose/pdf/prescribing/CDC-DUIP-QualityImprovementAndCareCoordination-508.pdf 

 Here is how you can use the RRIP to identify these patients: 
1. Make sure Fast Mode is checked (i.e. the TDMME by Patient tab’s pivot graph will not be highlighted)

2. Run and session log a CSM report for the last quarter (90 days will probably suffice)
3. When RRIPing the report you will use the following parameters:

Threshold: 1
Upper Threshold: 0
Number of Days Above Threshold: 60
Display Non-Opioids: Yes or No is fine here (No will be a tiny bit faster)

Note: If you’ve followed the steps above but you get a pop-up message saying the threshold value is
too high, it means you don’t have anyone who had opioids for 60 or more days during the quarter.

[Back to Top] 
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4. Once the report finishes processing, click on the TDMME by Patient tab

5. In the key just above the pivot table you will see the total number of patients who have a Total Daily
MME ≥ 1 in parentheses (arrow #1 below – in this example there is only 1 patient).  Additionally, if
you would like a list of all the patients so you can check charts to see if they have received naloxone,
PDMP checks, pill counts and urine drug screens, you can do the following:

a. Open a new Excel worksheet (i.e. click on start, type Excel, and click on the Excel icon,
choose to create a new worksheet)

b. Go back to your RRIP’d report and click just below the column title “Patient (Chart #)” –
arrow #2 below – this will highlight all the patient names

c. Right click and choose “copy” or hold down the “ctrl” button and hit “C” on the keyboard
d. Toggle over to the Excel worksheet you opened in step “a.” above, click in cell A1, then right

click and choose “Paste” or hold down the “ctrl” button and hit “V” on the keyboard
e. If you keep this list (and update it with comments from your naloxone chart reviews), then

when you run the next quarter’s report you can compare the old list to the new list.  By
doing so, you will only need to do a chart reviews of the new patients.  There is an easy way
to do this comparison using Excel’s Vlookup function, but is a little out of the scope of these
instructions

CSM Report - Printing the TDMME by Patient Pivot Table 
(Skip to page 14 if you have not yet RRIP’d a report – Come back here when/if you need to print the TDMME by Patient tab) 

There may be times when you want to print the TDMME by Patient pivot chart from the RRIP’d version 
of the CSM Report. Below are some tips to help you get a usable, printed version of the table. 

1. Click on the “Page Layout” tab at the top of the screen.

1 

2 
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2. Click on the cell just below “Average TDMME/pt. for . . .” so a box shows around it.

3. Scroll to the bottom right of the pivot table, hold down shift, and click the bottom right corner.
This will select the entire table.

4. Now that you have the table highlighted, set your print area by clicking on the Print Area icon
then choosing “Set Print Area”.

5. Set Margins to “Narrow” and Orientation to “Landscape”.

Hold down shift before 
you click the bottom 
right corner of the table 

[Back to Top] 
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6. Set up the page to print rows 9 and 10 and columns A and B on each page by clicking on Print
Titles and in the window that pops up type “$9:$10” in the box labeled “Rows to repeat at the
top:” and “$A:$B” in the box labeled “Columns to repeat at the left:”.

7. Play with the “Scale to Fit” settings until you get what you want. Use print preview to see if you
are getting what you need.

8. If you want to show the row and column labels on your printout, you will need to tell Excel that
you want to print the headings. This may be helpful if you want to be able to point out patients
more quickly when looking at the printout with a group.

1 

2 

A setting of “1 Page” on the height will fit all 
the rows into 1 page. You will need to adjust 
this setting to more or less pages depending 
on how many patients you have above the 
threshold

A setting of “2 Pages” on the width will fit all 
the columns into 2 pages. You will need to 
adjust this setting to more or less pages 
depending on the time frame of the CSM 
report

3 
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9. If you want to adjust column or row widths/heights to better accommodate your printing needs,
you will need to add headings back to the sheet as pictured below. After you have done this, you
will be able to adjust the column or row widths/heights as you see fit.

10. Make sure to check print preview before actually printing the document, but at this point, you
should have what you need to get the TDMME by Patient pivot table printed in a decent format.

11. If you have the option, you may want to consider printing this report on legal sized paper.

12. Some sites might find it better to run the CSM for a month at a time so that all the columns will
fit on one page, but you may still have a problem with all the rows fitting on one page.  You will
have to play with the scale setting to see what works best for you.

CSM Report – Combining Sites from Separate Databases

1. Run and session log the CSM for database #1
2. Run and session log the CSM for database #2 for the same dates used in #1
3. Open the session logged file for database #1
4. Open the session logged file for database #2
5. In database #2 copy from the line that starts with Pharmacy Division: __________

to the bottom of the document.  Make sure to include the Pharmacy Division: line in the copied data. 
One way to quickly do this is to: 

a. Place the cursor in front of the “P” in Pharmacy Division:________
b. Drag the scrollbar on the right side to the bottom of the document
c. Hold down the shift button and click to the right of the last line in the document
d. Hold down the ctrl button and hit “C” to copy to the clipboard (or right-click and copy)

6. Paste what you just copied just above the statistical totals towards the bottom of the session logged
file of database #1, then save the document

7. RRIP the session logged file of database #1 that now contains the data for database #2

1 

2 
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CSM Report – Removing a Division You Can’t Remove When Running the Report 
Caution: If you do not perform the steps below correctly you may end up with erroneous data.   

1. Run and session log the CSM report
2. Open the session logged file
3. Hold down the “Ctrl” key and push the “F” key. This will pop up a search box.  Search for the division

you are wanting to delete by typing “Division: DIVISION NAME” then clicking “Find Next”.  This will
take you to the Division you want to delete.  You will need to select from the line that starts with
“Pharmacy Division:” all the way down to the next line that says a new pharmacy division or to the
bottom of the session logged file if the division you want to remove is the last division listed.

4. After you have deleted the section of the logged file for the division you don’t want, make sure you
save the document.

5. RRIP the edited session logged file which should display only the division(s) you want.
a. Verify you successfully removed the unwanted division by clicking on the Division auto filter

on the main CSM or CSM + ERxT Import tab and seeing if only the division(s) you wanted are
in the division list.

You are ready to go.  The rest of this document is for reference only. You do not need to read it before 
beginning to use the RRIP. 

Troubleshooting 

CSM Report – Drug Name Too Long 

If you get a “Type Mismatch” error when running the CSM, most likely it is because one of your drug 
names is too long in the RPMS drug file and causes the CSM report to push the QTY line over to the 
right.  To fix this, do the following (you will only have to do these steps once): 

1. You should have a drug name written down from the Type Mismatch error instructions that you
received.  If you do not, please run the RRIP again and make sure to follow the instructions in
the error message before coming back here for further instructions.

a. If your error message does not have instructions, please contact me at
nicholas.sparrow@ihs.gov.

2. Open your .txt file of the CSM report you are using
3. Hold down ctrl + f (this will bring up a “find” box)
4. Type in the drug name from #2 and hit “Enter”
5. Look to the right of the file where the QTY column is (this comes right after the drug name)
6. You are looking for a place where the drug name runs into the qty, causing the QTY to shift to

the right.
7. You may need to keep clicking the “Find Next” button until you find the dosage form of the drug

from #2 that is causing the problem
8. You’re looking for something like this:

HYDROcodone 5MG/APAP 325MG U/D TAB *CLINIC-Prepack*1  1   C-II 
9. Notice how the drug name runs into the QTY (highlighted in yellow)

[Back to Top] 
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10. Modify your drug name (GENERIC NAME) in the drug file so that is the same as the VA PRINT
NAME or close to it (CMOP prefers the VA PRINT NAME, but if part of it is confusing, it can be
modified slightly to fit local need – the crucial piece is making sure it isn’t so long that it pushes
the QTY column over in the CSM report).

a. To find the VA PRINT NAME, pull up the problem drug in drug enter/edit and rematch it
to the national drug file.

b. When you are re-matching, the VA PRINT NAME will be displayed. You may want to
highlight and copy this name.

c. Change the GENERIC NAME in the drug file to the VA PRINT NAME (or what works best
for your local needs)

11. If you have multiple drug names in the drug file that are too long, you may have to repeat this
process multiple times.

12. Rerun your report and RRIP it.
13. You should be golden.

Ellipsis here will replace everything 

Paste copied VA PRINT 
NAME or use local 
customized name 

Make sure to leave the Long Name 
alone. This name has to be very specific 
for SureScripts and eRx 

Current Name 
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CSM Report – Sig with Problem Text 

If you get a “Type Mismatch” error when RRIPing a CSM report, and the drug name is blank when you 
hover over sDrugName, it is most likely because of a sig in your session logged CSM Report.  Once in a 
while a sig will contain something that conflicts with the RRIP program’s methods of identifying which 
line it is working with.  To fix this, do the following (you will need to do this each time you get this error 
and the sDrugName is blank – or you can just modify the sig in RPMS to fix it permanently): 

1. You should have a sig written down that you obtained by hovering over “tc” when debugging
the code

2. Open the session logged CSM report
3. Hold down the “ctrl” key and hit the “F” key to bring up a find box
4. Type a unique piece of the sig you wrote down into the find box and click “Find Next”
5. If you searched for a unique enough part of the sig, it should take you right to the problem sig.
6. At this point you can do one of two things.

a. At a minimum delete anything from the sig that isn’t usually in a sig (e.g. dates, commas,
etc.). Alternatively, you can delete the whole sig line if you don’t need it.

b. If you are planning on RRIPing more reports that would contain this entry, you will want
to go into RPMS and edit the sig (if possible) to remove the items mentioned in “a.”

7. Save the file
8. Re-RRIP it

CSM Report – Windows 10 or Office 2016 Not Allowing Macros 

If you see the red banner in the image above when opening the RRIP for the first time, you may need to 
follow the steps below to be able to use the macros in the RRIP: 

1. Open Internet Explorer
2. Click on the gear-looking icon at the upper right of the window
3. Click on “Internet Options”
4. Click on the “Security” tab
5. Click on the “Local intranet” icon
6. Click on the “Sites” button
7. Click on the “Advanced” button
8. In the field “Add this website to the zone:” type the server location where your RRIP file is

stored. I would suggest not putting the specific folder in here, but rather the core folder for your
department.

It will be something like \\phxtestserver\departments\pharmacy\.  You might have to ask your
IT for this, but if you pull up “This PC” or “My Computer” and click on your mapped network
drive, it should give you the location in the address bar at the top of the window.

[Back to Top] 
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9. Once you have entered the address, click the “Add” button.
10. Close Internet Explorer.
11. Close and reopen the RRIP. – Remember that you have to manually “Allow access to the VBA

Project Module” as described on pages 8 and 9 for everything to work well if you are using the
new 2016 version for the first time.

Appendix A (Copy of In-program Instructions) 

Getting Started 
Welcome to the RPMS Report and Information Processor (RRIP)! 

RRIP is an automated way to quickly get reports from RPMS into a filterable, sortable, easy to use Excel format. 
The vision for RRIP is to help IHS use data more effectively to produce better outcomes, more revenue, and 
improved transparency not only on a local level, but on an area and national level.   

Below is a summary of some of the basic items you will need to get started. For more detailed instructions please 
refer to the RRIP User Manual. Rather than clicking the "Ok, I've got it" button, you may minimize instruction 
popups like this one so you can bring them up later if needed.  

Once you close this page you will see a menu of different colored buttons.  Each button will format the report 
listed on the button. To navigate to other department/category buttons, please use the tabs at the bottom.   

This is a macro enabled workbook and therefore you will most likely have to tell Excel that you trust this file before 
it will let you use the macro. Once you close these instructions, you will need to click on the button on the warning 
bar towards the top of the screen that says "Enable Content."  Once you do this, you will need to close Excel and 
reopen the file before it will start working as expected.  

To get started using RRIP you will need to do the following: 
1. Open a standalone telnet client (e.g. NetTerm, SecureCRT).
2. Change the max columns to at least 180.

a. In NetTerm go to Tools -> Desktop Settings -> change 80 to 180 and click save
b. In Secure CRT to Options -> Global Options -> Terminal -> Appearance -> change Max Columns to

180 and click "OK"
3. After you have clicked the "Ok I've got it" button or minimized this window:

a. Click on the tab of the category that best represents what type of report you need to format
b. Click on the "General Instructions" button and follow the instructions
c. Click on the button for the specific instructions for your report

CSM In-program Instructions 

Using Autofilters  
Now that your report has finished processing, let me go over a few items to make sure you get the most out of it. 
Below is a small tutorial on how to use this report. Leave this window open while you go through the instructions 
so you can refer back to them as needed. You can drag this instruction window around the screen (by clicking and 
dragging the top area of the window) if needed. This functionality is available for all instruction windows. 

First, you will notice a small down arrow to the right of each column header. These are called autofilters. Find a 
column with multiple data and click the autofilter to expand it. You will notice sort options as well as filter options. 

[Back to Top] 
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The first two options are for sorting from A to Z (smallest to largest) or Z to A (largest to smallest). You will also 
notice a bunch of check boxes that are filters. Go ahead and choose one of the sort options and notice how quickly 
Excel sorts the entire sheet for you. 

Click on the autofilter again and look at the checkboxes. These are your filters. Notice the (Select All) box at the 
top. Uncheck this box and notice how it unchecks all the boxes below it.  Now scroll through the unchecked items 
until you find one or more you want to check, and check it/them. Now click on "OK" and notice how only the 
results with that item are displayed. To display everything again, click on the autofilter again, and check the 
checkbox next to (Select All) again.  

Sometimes you will have a column that has blanks in it. Filtering to show only the blanks can be helpful. You may 
not have a column to do this with in your current data, but it is something to keep in mind. To show just the 
blanks, uncheck the (Select All) checkbox and check the box next to (Blanks). (Blanks) will usually be at the very 
bottom of all the other checkboxes.  

Lastly, you can have multiple filters and multiple sorts at one time. To apply multiple sorts (up to three) sort the 
least important column first, then the next most important column, and finally the most important column. Notice 
how the sorts carry over. To apply multiple filters, merely filter one column, then the next, then the next. 

How to Use the CSM 
**** A copy of all in-program instructions can be found at the end of the User Manual that is embedded in the 
main RRIP Excel file.  You can find it by clicking on the green tab labeled "User Manual" then following the 
instructions.  

Now that you know how to use the autofilters, let me explain how to use the CSM or CSM + ERxT report. You are 
currently looking at the CSM or CSM + ERxT Import tab which contains the raw data from the CSM and/or ERxT 
reports. Remember you can use the filters to look at, for example, scripts for a specific provider, or to look at only 
the CII scripts. If you chose to display pivot tables, read below: 
**** VERY IMPORTANT**** In order for the Morphine Milligram Equivalents (MMEs) to calculate correctly, make 
sure all the opioids in your drug file use generic names, include a dosage form, do not abbreviate the opioid name, 
and don't have package quantities in the name. An easy way to do this is to sort the drug name column A-Z then 
look down your DMME (Daily MME) column and look for any place the drug is an opioid but the DMME has not 
been calculated (injectables, all buprenorphine dosage forms, opium, opioid containing cough and cold 
formulations, and opioids with a quantity of 2 or less and a days supply of 1 will not have a calculated DMME - all 
other opioids should). Note the drug name and make the needed change in your drug file, then run the CSM 
and/or ERxT again and import it using the RRIP - (See the "Troubleshooting" section of the RRIP User Manual on 
how to do this). Repeat the steps in this paragraph until you can verify that MMEs are being calculated for all 
opioids. At this point you no longer need to worry about checking this, but should ensure that any new opioids 
added to the drug file are added following the guidelines above. The steps in this paragraph should be performed 
on a CSM and/or ERxT report of 6 months or more if possible.  

Please note: Some entities use MED (Morphine Equivalent Dose) and MEDD (Morphine Equivalent Daily Dose) 
instead of MME and DMME, but MME and DMME will be used in the RRIP.  

If you chose to display pivot graphs and tables, you will notice many tabs at the bottom of the workbook. The 
other tabs at the bottom of the workbook contain pivot charts which will help you better use the data in the CSM 
or CSM + ERxT report. These charts have autofilters on them as well.  They are located on the chart itself (or next 
to the chart) rather than as column headings.  Each chart has an explanation of what the chart is and how to use it 
directly above it.  

[Back to Top] 
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Most likely there are more tabs at the bottom of the workbook than your screen will display. To get to the tabs 
that do not display, click on the little arrows to the far left of the tabs. The ones with the lines will skip you to the 
end of the tabs, or the beginning. The others will just move you forward or backwards one tab at a time. 

If you want to see the data that was used to create a pivot chart (or table), simply double-click on the total for the 
line you are wondering about (at the right side of the pivot table).  A new tab will be created displaying all the data 
used to get the total you clicked on.  Once you don't need the data anymore, you can right click on the new tab 
that was created (usually "Sheet 3" or "Sheet 12" or something like that) and choose "Delete" without affecting 
any other data in the report. Subsequently, you will get a pop-up asking if you want to permanently delete the 
data – for a second time choose "Delete".  

If you would like to filter out some of the drugs from your imported data for the purposes of the pivot charts, you 
can use the "Drug Name" filter associated with each chart (please note that the following data will not be updated 
when filters are used because they are calculated during the RRIPing of the report and are not part of the pivot 
tables: 1. Total number of patients who received any opioids, 2. Average TDMME/pt. for patients who received any 
opioid, 3. Total Number of Injectable and In-house Scripts for All Divisions Combined, 4. Total # of Outpatient 
Opioid Scripts for all Divisions Combined). 

NOTE: In order to get your pivot charts to auto-resize (and a few other crucial functions) when you start filtering 
the results, you will need to follow the instructions given in the RRIP User Manual (Allowing for Automatic Graph 
Resizing). If you have not already done this, please do so, then re-RRIP the .txt/.log file. Once you have made the 
changes, you will not have to make them again. 

How the RRIP Calculates MMEs 
Morphine milligram equivalents (MMEs) allow you to compare doses of opioids across patients by standardizing all 
opioids to morphine. The RRIP uses the script quantity and days supply to calculate the MME's of each opioid (the 
sig itself is irrelevant). Therefore, it is imperative that you ensure the days supply for each opioid is reviewed and 
corrected during script processing. If this is not currently happening, please work with your local pharmacy and 
medical staff to correct this. Until that time, your DMME data, while still useful, may not be 100% correct.    

Daily MMEs (DMMEs) are calculated as follows: 
# tabs/day (qty/days supply) x # mg/tab x conversion factor. 

Total MMEs (TMMEs) are calculated as follows: 
qty x # mg/tab x conversion factor 

The conversion factors used in the RRIP come from the Centers for Disease Control and Prevention (CDC). A link to 
the conversion factors is found in the black “CDC Documents" tab in the main RRIP workbook.  

In order to allow users to compare their data to data produced by the CDC, the RRIP uses the CDC methodology.  
Therefore, MMEs are not calculated for the following opioids: injectables, all buprenorphine dosage forms, opium, 
opioid containing cough and cold formulations, and opioids with a quantity of 2 or less and a days supply of 1. See 
the grey Definitions and Explanations tab in the main RRIP workbook for more details.   

As new drugs are added to the market, their conversion factors will need to be programmed into the RRIP. If you 
add a newly approved opioid drug to your formulary, please feel free to contact the developer to verify that the 
drug has been included in the RRIP's MME calculations. 

CSM + ERxT In-program Instructions 

Note on the Limitations of the ERxT Report 
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RRIP cannot account for refills of controlled substances that appear on the ERxT report.  For the purposes of opioid 
management this really only affects the few items that can have refills (e.g. tramadol and T3). However, the RRIP 
will account for multiple scripts being written on the same day as in the case of CIIs which are written with a future 
fill date so long as each script is ordered separately - giving each a different script number in RPMS. 

One other limitation exists. The ERxT report does not exclude deleted scripts.  If for some reason one of your ERx 
or Outside Pharmacy - Print scripts was recalled and deleted, it will still show up on your report. 

For more information on the above issues, please see the Item named "Limitations of the RRIP for CSM + ERxT" in 
the "Explanations and Definitions" tab of the main RRIP workbook. 

The rest of the ERxT Instructions are pretty much the same as for the CSM (already listed above) 

RCR In-program Instructions 

Using Autofilters (RCR version) 
Now that your report has finished processing, let me go over a few items to make sure you get the most out of it. 
Below is a small tutorial on how to use this report. Leave this window open while you go through the instructions 
so you can refer back to them as needed. You can drag this instruction window around the screen (by clicking and 
dragging the top area of the window) if needed. This functionality is available for all instruction windows. 

First, you will notice a small down arrow to the right of each column header. These are called autofilters. Find a 
column with multiple data and click the autofilter to expand it. You will notice sort options as well as filter options. 

The first two options are for sorting from A to Z (smallest to largest) or Z to A (largest to smallest). You will also 
notice a bunch of check boxes that are filters. Go ahead and choose one of the sort options and notice how quickly 
Excel sorts the entire sheet for you. 

Click on the autofilter again and look at the checkboxes. These are your filters. Notice the (Select All) box at the 
top. Uncheck this box and notice how it unchecks all the boxes below it.  Now scroll through the unchecked items 
until you find one or more you want to check, and check it/them. Now click on "OK" and notice how only the 
checked items are displayed. To display everything again, click on the autofilter again, and check the checkbox next 
to (Select All).  

Sometimes you will have a column that has blanks in it (for instance, the "Status" column). Filtering to show only 
the blanks can be helpful. For instance, if you change the status of claims as you fix them, and you have the 
"Status" column autofilter set to (Blanks), only the claims still needing to be worked on will be displayed. Even with 
this setup, the Statistics tab will continue to keep track of your progress. 

To show just the blanks, uncheck the (Select All) checkbox and check the box next to (Blanks). (Blanks) will usually 
be at the very bottom of all the other checkboxes.  

Lastly, you can have multiple filters and multiple sorts at one time. To apply multiple sorts (up to three) sort the 
least important column first, then the next most important column, and finally the most important column. Notice 
how the sorts carry over. To apply multiple filters, merely filter one column, then the next, then the next. 
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How to Use the RCR Report 
Now that you have learned to use autofilters, let me explain how to use the RCR report. The key to making the RCR 
report useful are the autofilters. Here are a couple of ideas of how to use the autofilters to get the most from the 
RCR report. 

1. If you are short on time, Sort the "Amount" column from
Largest to Smallest and work the largest items first.

2. Filter the rejections column to specific rejections that you know
you can fix quickly and take care of them.

3. Filter to a specific insurer that has a short back billing period and
take care of those first.

4. Filter to a specific insurer and take care of all the claims for that
insurer while you are on the phone with the insurance
representative to save yourself having to go through the
annoying menus more than once.

5. If you are using the "Status" column, filter it to only show blanks
so that as you process claims, only the remaining ones are
displayed. It is recommended that you make the "Status"
column your first column (Column A).

6. Get creative with the filters and sorts to make the best use of
your limited time. You can stack one filter on top of another.

How to Use the “Status” Column and “Statistics” Tab 
You have chosen to display the "Statistics" tab. To make it easier for you to learn how to more effectively use this 
report, leave this box open and go through these instructions. Please notice the down arrow at the right side of the 
first cell in the "Status" column. Click on the down arrow and change the status of that claim.  

To apply the same status to multiple cells click and drag down the little box that appears when you hover over the 
bottom right of the "Status" cell you just changed. This will apply that same status to all the rows you drag across. 

****Remember that the use of autofilters can quickly filter your results so you can apply a status to a group of 
related claims**** 

After you have changed the status of a few of your claims, click on the "Statistics" tab at the bottom of the 
worksheet to move to the statistics page where you will see statistics based on the items you changed the status 
of.  

You should now be on the "Statistics" page.  

Please note that the amounts listed in the statistics tab are the billed amount. To get an accurate picture of what 
you might expect to collect on those claims, do the following: 

1. Go to RPMS
2. Run the Payable Claims Report for a 2 month period
3. Divide the total paid by the total billed (you should get something between

0.5 to 0.7 or thereabouts)
4. Multiple that number by the "Fixed" amount on the "Statistics" page to get a

rough estimate of what you can expect to get paid for those claims.
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